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1 Purpose

The purpose of this document is to provide an introduction on using the Spagic3 platform: it does so with walkthrough of
the design, deployment and the monitoring stages of a sample BPEL process.

For this purpose, Spagic Studio integrates on the Eclipse platform, the BPEL Designer to model the processes and
Apache ODE runtime to execute them.

Installation and configuration of the BPEL Designer in Spagic Studio and ODE are outside the scope of this document.

2 Versions History

Version/Release n°: 1.0 Date 23/09/2009
Description First release (English version)

Version/Release n°: 2.0 Date 10/05/2010
Description Updates for Spagic 3.0.0

BPEL processes with Spagic3 ver. 1.0, July 30, 2010 - pag. 3/ 28

licensed under the Creative Commons Attribution-ShareAlike License. To
view a copy of this license, visit http://creativecommons.org/licenses/by-
sa/3.0/

@Creatl\le Engineering Ingegneria Informatica S.p.A., 2007, 2010. This work is

COMMONS DEETD




SN Spagic

Open Source SOA Universal Middleware

BPEL processes with Spagic3

3 Introduction

Spagic3 platform allows designing, executing and monitoring BPEL processes.

Spagic 3 allows creating BPEL processes either from BPMN diagrams or, new to this version, by using the
integrated BPEL designer.
In fact, in previous versions, to design a BPEL process in order you had to:
¢ model a BPMN diagram representing the process, using the BPMN editor integrated in the platform,
e generate the intermediate model by the BPMN diagram,
e generate the BPEL process by the intermediate model,
o complete the BPEL process with technical configurations and data, using th BPEL designer editor integrated in
the platform,
e deploy the intermediate model into meta database,
e generate the service assembly and publish it in servicemix, where it is executed and monitored.
The process executions are displayed through the console. The following figure shows the flow:

BPMN Diagram

oy = :> Meta DB
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In Spagic3, to design a BPEL process you can:
o model the BPEL process using the BPEL designer editor,
o deploy the process into the Apache ODE, the BPEL engine, where it is executed and monitored.
The intermediate model generation is transparent to the user.
The process executions are displayed through the console.
The following figure shows the flow:

®

= main

& | receiveInput
BPEL Process .
= assign :> BPEL Engine
42 | replyOutput ﬁ
@
Intermediate Model p— :> Meta DB

This document is organized as follows:
e A section that shows how to design a process and also a how to configure the port, the binding and the
deployment descriptor associated,;
e A section that explains how to execute it;
e A section that introduces the console to monitor the process execution;
e A section with some examples associated with the main BPEL constructs.
For more details about Spagic Console, see the document Spagic Studio User Guide.doc
For more details about Spagic Studio environment see the document Spagic Studio User Guide.doc.

BPEL processes with Spagic3 ver. 1.0, July 30, 2010 - pag. 5/ 28

creative Engineering Ingegneria Informatica S.p.A., 2007, 2010. This work is
@ mmons licensed under the Creative Commons Attribution-ShareAlike License. To
view a copy of this license, visit http://creativecommons.org/licenses/by-
sa/3.0/

COMMONS D EED




SN Spagic

B P E L p rocesses w | t h S p a g | c 3 Open Source SOA Universal Middleware

4 Requirements

Required Tools URL for download/Notes Required for |Required for
Spagic Spagic
Studio Console
Database MySQL
Oracle \/ \/
H2
Apache ODE 2.0 Beta http://ode.apache.org/ ‘/
GraphViz http://www.graphviz.org/ ‘/
JDK 1.6.X or later http://java.sun.com/ ‘/ ‘/
Apache Tomcat 6.0.x http://tomcat.apache.org ‘/
Mozilla Firefox 3.x http://www.mozilla.com ‘/
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5 Developing a Process

Spagic Studio is an Eclipse environment that allows the use of a single interface in order to create components and
processes managing the entire development cycle. For the details, see the documents Spagic Studio User Guide.

Spagic Studio integrates the Bpel Designer to design BPEL processes.

In this section we’'ll shortly describe all steps to develop a BPEL process using a simple example.

5.1 Create a Spagic3 project

Open Spagic Studio and create a workspace for working, for example call it SpagicDemo.
As first step, configure the Spagic General Preferences from Window->Preferences-> Spagic General Preferences; set
the attributes for:
e the graphviz application in the main page, section Graph Viz;
e the ODE urls in Spagic BPEL tab;
e the metaDB in Spagic Meta Database tab.
To create a new project, select File->New->Project->Spagic->Spagic3 Project, insert a Project Name, StartSpagic, click

Finish.

{F New Project

SE'I‘E'Et d WiZEII'd '__1'::-':;.-

Wizards:

B BPEL 2.0 ~
E-= Cvs
[H--[Z= Eclipse Modeling Framewark
= EB
E-[= Java
E-(= JavaEE
H-= Javascript
H-E= JET Transformations
H-E=- I
== Plug-in Development
- [= Spagic

B ocroes
(= Web
#- (= Examples v

=
© .. =

In the workspace, the project just created has a standard structure containing the followings directories:
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Connectors, Processes, Resources, Services.

5.2 Design the process

To define a new process, select the Processes folder, open the context menu and New->Other->BPEL2.0->New BPEL
Process File, click Next. Insert the BPEL Process Name, for example FirstProcess, the Namespace, for example

urn.firstprocess and select the template Synchronous BPEL Process as shown in the following screenshot.

Create a BPEL Process File
Create a 2,0 BPEL file.

Process Details
BPEL Process Name: | FistProcess
Marnespace: g-urn.FirstprDcessi . V-'
Template: é_-SynchanDus BPEL Process v-_

Generates an empty BPEL process, Only receive and reply activities are placed in the process
body. The caller will block until all the steps in the process have completed. & client inkerface

is generated,

[]abstract Process

'::?j < Back ][ Mext = ][ Finish H Cancel

Click Next, select SpagicDemo folder, then Processes folder, click Finish.
Spagic Studio will show in the BPEL Designer editor the process just created.

The result should be similar to the following screenshot.
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2 FirstProcess.bpel &3

main

e | receivelnpuk

W | rephyCiutput

®

To complete the process, select, from the palette located at the right of the editor, under the category Actions, an Assign
activity and put it to the editing area, between receivelnput and replyOutput .

Select the Assign activity in the editor area, right-click, select Show in Properties. In the Details page, we create an
assignment, selecting New, then select From Variable and specify the payload for the input. Select To Variable and
specify the payload for the output. Click Yes, when the dialog relative the Initialization variables is displayed. Save the
process.

= Assign
Description D Validate
Details [Fixed value to variable | From: | variable [ To | variable |
Jain Behavior bl= | T . - .

- =l @ input : FirstProcessRequestMessage [#- @ input : FirstProcessRequestMessage
2L H Il #-17] payload : FirstProcessRequest =@ output ! FirstProcessResponseMessage

@@ output @ FirstProcessResponseMessage = i.j payload | FirstProcessResponse
[ Hew ][ Delete Query: Query: |
Move Lp 0 [J1gnore Missing Source Data [[]keep Source Element Name

5.3 Configure Port and Binding

In order to execute the process, we have to define a Port and a Binding. Double-click on the file FirtProcesArtifact.wsdl to
open the Wsdl editor. Select the editor area, open the context menu, and select Add Service. Configure the name as
FirstService. Rename the NewPort in FirstPort and configure this as shown in the following screenshot.
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= port
General Marne: | FirstPark
Documentation Binding: |
Extensions
Address: | htkp: fflocalhost: §080/ ode processes First
Prakacol: | S08P

Save the wsdl file.

Select the editor area, open the context menu, and select Add Binding. Configure the name as FirstBinding, in Port Type
select FirstProcess, click Generate Binding Content, in the dialog select the Protocol SOAP, and click Finish.

binding
General Marne: | FirskBinding
Documentation PortTyvpe: | FirstProcess
Extensi
AEnsans Protocal: SOAP

|§Generate Binding Content, ..

In the editor area, select the FirstPort and configure his Binding selecting FirstBinding.

E port

General farmne: | FirstPart

Documentation Binding: | FirstBinding

Extensions
Address; | htkp: /flocalhost: 3080/ ode/processes) first
Pratocal; | S04

Save the wsdl file.

The result should be similar to the following screenshot.
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SZ FirstProcess, bpel 7B FirstProcessartifacts.wsdl 3

O FirstProcess

Design | Source

[ payload [&] FirstProcessRequesk

L5 First3ervice m
= FirsktPort i process
http:filocalbost: G080/ ode., . [input
<:]j autput

[ pavload [&] FirstProcessResponse

(21 problems | @ Javadac |_{¢> Declaration | ‘@] Error Log | 5 Properties &2

E port
General hisme:
Ciocumnentation Binding:
Extensions
Address:
Protaocol:

[ Firstrort
[FirstBinding
.i.ﬂttp:,lf,l;luca.lﬁust:8DSD;I;.Dci_e!f.prucessesll'ﬁrst

SOAP

=i
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5.4 Configure the deployment descriptor
In order to deploy the process, we have to generate and configure an ODE deployment descriptor file.

Select the Processes folder, open the context menu, and select New -> Other -> BPEL2.0 -> Apache ODE Deployment

Descriptor.

- BX

Select a wizard <

Wizards:
|- pe Filker ket
== BPEL 2.0 A
; 1 Apache ODE Deployment Descriptor
1% BPEL Project
Q Mew BPEL Process File
® (2 Connection Profiles
HE Cvs L
[ Eclipse Modeling Frammewark
#-[Z= Ecore Tools
E-E EIB
& [ Example EMF Madel Creation 'Wizards
+-[7= EMF-%pand
[= Graphical Modeling Framework,
== lava
== lawaEE v

IRl TR |

-

Ny

:

Click Next, check that the BPEL Project has been set to /SpagicDemo/Processes. Click Finish.

In the Processes folder, the deploy.xml file has just been generated. Right-click on deploy.xml file, select Open With
-> ODE Deployment Descriptor Editor. Associate the port FirstPort to client partner link, as shown in the following

screenshot. Save the file.
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.Q, FirstProcess,bpel Z# FirstProcessartifacts, wsdl T *deploy,xml 3
Q Process FirstProcess - urn.firstprocess

* General

This process is iactivated_gi
|:| Run this process in memary
+ Inbound Interfaces (Services)

The table contains inkerfaces the process provides, Specify the service, port and binding wau want ko
use For each PartnerLink, listed

| Partner Link  Associaked Port Related Service Binding Used
i clienk FirstPark Jurn.firstprocessHFirskService

+ Outbound Interfaces {Invokes)

The table contains inkerfaces the process invakes, Specify the service, part and binding wou want ko
use For each PartnerLink listed

Partner Link | Associated Port | Related Service | Binding Used

+ Process-level Monitoring Events

{:} MNone
&l
7 Selected

[

+ Scope-level Monitoring Events
FirstProcess

5.5 Publish the process

After designing the process, you have to publish it: this operation execute the following steps:
e generates the Intermediate Model associated to BPEL process,
e creates a .zip containing .bpel, .wsdl, deploy.xml,
e deploys the process into Apache ODE,
e retrieves the version process from ODE and set it into the Intermediate Model,

e saves the process information (properties, flow...) into the MetaDB.

Before the publishing, assure that Apache ODE ‘s running.

To publish the process, select the .bpel file, open the context menu and select Spagic BPEL->ODE Deploy.

Spagic O5Gi

3
Spaqic BPEL k DDE Deploy
SOurce » QDE Undeplow
LKL T ek e 0
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0¥ Spagic

When the dialog appears, click Ok.

When the publishing is completed, the following dialog will be displayed.

Publishing completed

In the Apache ODE console, the

Tomcat

GeronimoLog.debug{66>
GeronimoLog.debug{66>
— GeronimoLog.debug{66>
GeronimoLog.debug{66>
e.bpel.epr.YSAEndpo int@848chE
DEBUG — GeronimoLog.debug{66>
DEBUG — GeronimoLog.debugt{bh>
DEBUG — GeronimoLog.debug<tb>
rdndbo?ceku5) . .
DEBUG — GeronimoLog.debug{bh>
ho?Pcekes)
INFO — GeronimoLog.infod79>
dbo7cekub>
IMF0Q - GeronimoLog.info(79> |
dbo7cekub).
INFO — GeronimoLog.infol79> |
DEBUG — GeronimoLog.debugt(bh>

deployment is displayed in this way:

Destroying service {urn.firstprocesz}FirstService port FirstPort
Couldn’t find service {urn.firstprocess*FirstService port FirstPort to destroy

Created fAxis? service {urn.firvstproceszs}FirstService
Activated {urn.firstprocess}FirstProcess—1 myrole client: EPR is org.apache.od

fictivated {urn.firstprocess¥FirzstProcess—1
Rehydrating process {urn.firstprocess*FirstProcess—1
Creating new process DAO for {urn.firstprocess2FirstProcess—1 <(guid=hgejhhcnph

i Creating process DAO for {uen.firstprocess}FirstProcess—-1 {guid=hgejbhcnphr4md|

i Created new process DAO for {urn.firstprocess*FirstProcess—1 {guid=hgejbhcnphrdm

Created new process DAO for {urn.firstprocessiFirstProcess-1 <guid=hge jbhcnphrdm
Registered process {urn.firstprocess*FirstProcess—1.

i (Re?scheduling cron scheduled jobhs on store event: {ProcessStoreEventHACTUIATE

D:{urn.firstprocess>FirstProcess—1%

INFO — GeronimoLog.infol79> |
IMFQ - GeronimoLog.infFo(7/Y>
INFO - GeronimoLog.info(79)> |
DEBUG -~ GeronimoLog.debug{6b>
DEBUG + GeronimoLog.debug(6b>
DEBUG — GeronimoLog.debug{6b>
onOut InOp

BUG — GeronimoLog.debug{6h>

DEBUG — GeronimoLog.debug{6b>
DEBUG — GeronimoLog.debugt{bh>
ocess*FirstProcess-12

DEBUG — GeronimoLog.debug{6b>
rocessrFirstProcess—12

DEBUG — GeronimoLog.debug<tb>

=1
-1

PROCESS CROM johs for: {urn.firstprocess*FirstProcess
PROGESS GHOM jobs for: {urn.firstprocess:FivstProcess
of artifact FirstProcess—-1 successful.

! Deployed package: FirstProcess—1

i Deployed PID: {urn.firstprocess>FirstProcess—1

i The zystem iz checking for the operation using the following WSAAction: upn:an

1i

Cancelling
scheduling
Deployment

! Checking for Operation using SOAPF message body’s first child’s local name =

Found operation org_apache.axis2_description.InOutAxizOperationP4737a3
Process store event: {ProcessStoreEvent#SCHEDULE_SETTINGS _CHANGED:{urn.

! Ignoring store event: {ProcessStoreBEvent#SCHEDULE SETTINGS _CHANGED:{urn._firstp
{ProcessStoreEvent #SCHEDULE

irstpr

i (Re>scheduling cron scheduled jobs on store event:

 SETTINGS _CHANGED: {uPn.f1P“tpPDCeSS}FlP“tPPDCESS—i}

GeronimoLog.info {79
GeronimoLog.info(79>
GeronimoLog.info (79>
GeronimoLog.info (79>
GeronimoLog.info (79>
GeronimoLog.info{79> !
GeronimoLog.info{79> |

If you have some errors, verify that Apache ODE is running and you've installed graphviz tool and you've created the

| Cancelling PROCESS CROM jobs for: {urn.firstprocess}FirstProcess—1

Echeduling PROCESS CROMN jobs for: {urn.firstprocess>FirstProcess-1
Refrezshing SY¥STEM CRON johs.

SYSTEM CRON configuration found cron johs: [1

Refreshi SYSETEM CROM jobs.

SYSTEM CRON configuration found cron Jjohs: [1
Refreshing SYSTEM CRON

temporary directory that should be configured in the Spagic General Preferences, in the item Graphviz temp folder.

Spagic Studio Preference

+- Team
Validation
+- Web and XML
+- Web Services
+- ¥Doclet
< >

Detault Urganizaton Engineering

Graphviz dot program Location | C:/Programmi/ATT /Graphviz bin/dot

Graphviz temp folder Ciftmp

SMY GetResources Service http:/localhost: 9092 jgetResources)

Restore Defaults ] [ Apply
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6 Run the Process

To run the process select the FirstProcessArtifact.wsdl, right-click, select Web Services->Test with Web Services

Generate WIL

Explorer.
% Connectars st R
1+ Processes |2 Copy Chrl+C
T deploy.xml £ Copy Qualified Name
?Q FirstProcess.bpel ..:: Hacte St
i FirstProcess.im
;_‘;' Fir'::tF'r'n:u:Ee::::F'.r'tiF-an:t::.l.-'- X Delete BElete
[ Resources
= Services
I TerminationHandler R : 2
# VariablesInstancesTest Bl Path ;
_—‘f- wWehServiceProject Refactor Alt-+shift+T L4
£y Impart..,
L7y Export...
qg-"?* Refresh F5 E 5 :
Assign Working Sets... stion @1 Errar Log | &= Properties 2
Yalidate ke
Show in Remote Systems view T
Run As r Frie
Debug &s r 24 Sept
Profile As L4 False
Team . Test with Web Services Explorer |I|'pr':";
Compare With ¥ Publish ¥SOL File alis
Replace 'with b Generate Java bean skeleton mple:
Spaglc 058G K Generate Client ar |
3
3

Source

Navigate the tree on the left until you find process, select it, and insert in the input field “My first BPEL process”. Click Go.
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P FirstProcessartifacks, wsdl T deploy.xml (@ Web Services Explorer 35 =

Wb Services Explarer &siles 2 A
S Mavigator & | l A Actions @

S wWsDL Main . )
| 28 file: /: fprogettifSpagic) ActiveBPELTI €L Invoke a wSDL Operation Soulres
i FirstService
@ FirstBinding Enter the parameters for the WSDL operation "pracess” and dick Go ta invoke,
¥ 3 Endpoints

http:filocalhost; S080/ode/processes first |«

- Body

= FirstProcessReguest

input skring
My First process|

Reset |

In Apache ODE, the result should be similar to the following screenshot.

<input>My First Process{ /input’>
{</FirztProcesszRequest>{/payload>{/message’

DEBUG — GeronimoLog.debug{66> | invoke{> EPR= null ==> BpelProcess[{urn.firstprocess*FirstProcess—11]
DEBUG — GeronimoLog.debug(6t) mmiting ODE MEX {MyRoleMexithge jbhcnphrdmdbolcekv? [Client hge jbhenphr4mdbo?c
ekv6] calling {urn_firstprocess retService.processd._ .03
DEBUG — GeronimoLog.debug{6b6> | Commiting transaction.
DEBUG — GeronimoLog.debug{66> | handleWorkEvent: Invokelnternal event for mexid hgejbhcnphr4mdbo?ceku?
DEBUG — GeronimoLog.debug<6t> i >> handleWorkEvent<{jobhData={type=INUVOKE_IMTERMAL. mexid=hgejbhcnphrdmdbo?cekv?

pid={urn. f1r°tprocess}F1P°tPPocess—1})

BUG — GeronimoLog.debug{66> ! Invokelnternal event for mexid hgejbhcnphr4mdbo?ceku?

— GeronimoLog.debhug(6b> GET MEX property org.apache.ode.bpel.myRoleSessionld = null
GeronimoLog.debug(tb) GET MEX property org.apache.ode.bpel.myRoleSessionld = null
GeronimoLog.debug{6b> GET MEY property org_apache.ode_bpel._ partnerRoleSeszionld = null
GeronimoLog.debug{66> INPUTMSG: client.process: MS8G RCUD keys=[1 mySessionld=null partnerSessionld=n

GeronimoLog.debug{66> INPUTHEG: client.process: routing failed. CREATING MEW INSTANCE
GeronimoLog.debug{6b> BpelRunt imeContextImpl created for instance 251 . INDEXED STATE={>
GeronimoLog.debug{6h) SELECT: PickResponseChannel#?: USING CORRELATOR client.process
GeronimoLog.debug(bh) SELECT: PickResponseChannelli?: CHECKING for NEW IMSTANCE match
GeronimoLog.debug{66> INPUTHEGHATCH: Changing process instance state from ready to active
— GeronimoLog.debug{6b> SELECT : PickResponseChannelii?: FOUND match for NEW instance mexRef={HyRoleMexil
hge jbhecnphrdmdbo?ceku? [Client hge jbhenphrdmdbo?cekv6]l calling {urn.firstprocess}FirstService.processd... 03}
DEBUG — GeronimoLog.debug(tt) | Processing an async reply from service {urn.firstprocessiFirstService
DEBUG - GeronimoLog.debug(66> | ProcessImpl {urn._firstprocess>FirstProcess—1 completed OK.
DEBUG — GeronimoLog.debug{66> | Received myrole mex response callback
DEBUG — GeronimoLog.debug{66> | Handling response for MEX {MyRoleMexithge jhhcnphrd4mdbo?cekv? [Client hgejbhcnph
r4mdbo?cekve] calling {urn.firﬂtproce s}First8ervice.process(...02
DEBUG — GeronimoLog.debug(t6d | Starting transaction.
DEBUG — Geronimolog.debug<bb> | Response message <7?xml version='1_8' encoding="utf-8’'7>{soapenuv:Envelope xmlns
Isoapenv http://schemas.xmlsoap.org/soap/enuelope/"}(soapenu:Body)(FirstPPocessResponse xmlns="urn.firstproce
=g ">
<input>My First Process{ /input’
{/FirstProcessResponse >{/soapenv:Body><{ /soapenv:Envelope>
DEBUG — GeronimoLog.debug(6b) Releasing mex hqeahhcnphr4mdhu7ceku?
GeronimoLog.debug(6t) Comitting transaction.
GeronimoLog.debug{6b> Reply for first_.{uern_firstprocesstprocess
GeronimoLog.debug{66> ! Reply message <?xml version='1_.0' encoding="utf-8’'7?>{soapenv:Envelope xmlns:so
gpenu=”http://schemas.xmlsnap.org/soap/enuelupe/”)(soapenu:Body)(FirstPPocessResponse xmlns="urn.firstprocess"

{input*My First Process{ /input>
{/FirstProcessResponse>{/soapenv :Body>{/soapenv:Envelope>
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7 Monitor the Process

Spagic Console is a web application to monitor, through Ajax interface, the system information (system monitoring), the
services, and the processes (services monitoring).

It's recommended to use the Firefox Mozilla 3.x.

For more details about Spagic Console please read the document Spagic Studio User Guide.doc.

Start the Tomcat where you've installed the Spagic Console.

7.1 Authentication

The URL to launch the Spagic Console is: http://localhost:8080/Spadgic/.

The first page visualized by the web application is the authentication page.

Insert the user spagic and the password spagic and then click the button 24

1) spagic Consale - Mozilla Firefox =15 x|

Ele Modfica Wisuslzza Cronologia  Segnalbrl  Strumenti 2

- @ (% [F2 hetpuinecamestievantspacic; [zl B [Cle|sooge &

¥ Spagic

Passiard

. User Name
& —

Completato

The next page contains the application menu.

Ky
G
L)
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7.2 Process List

Select the icon Process List (Iflulfl) to view all processes and theirs configuration, properties, and static flow diagram. The

list contains the following attributes:

Name: process name.

Type: process technology.

Valid From: start validity date.
Instances: number of process instances.
Actives: number of active processes.
Failed: number of failed processes.

YV V V V V V V

Warning:

\4

“ : displays the process detail containing the description, version, organization, service name.

ﬁqﬁ: displays the process graph.

\4

The process list should contain only FirstProcess: the process just deployed and launched.

S &2 Ao | @ A4 G & Process List
tter
- —— _ Processes | Services || Connectors
Iter Type | All Processes Sl ) - - ) )
a) (4 Server:localhost bl Page 1 of 1 @
Hame Type |Valid From Instances |Actives |Failed |Executed |Warning |Monitoring Status
FirstProcess ‘Q /25109 1 i] 0 2, o LY 4 =, ﬁ“ﬁ
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7.2.1 Process Graph

Selecting the icon a from the process list, it's possible to display the process graph and on right side the list of global
variables defined in the process. In this case input and output.

In most cases, the activities designed with the BPEL designer editor correspond to the steps visualized in the console,
excepting the sequence and the scope activities; these are displayed only if an event handler or a fault handler has been
associated to them. In these cases, the step names have been renamed using a prefix start- and a suffix end- specifying
the start and the end activity. See the Samples section for more details.

Selecting the elements on the graph it's possible to display a window containing Name, step Description, Service and its
Properties.

@ 2 & o @ ik

2 A4 0 &

,,f" ““\_ Variables
?eceiwlru;uﬂ
J nput =4
'\._\_ i
c output
I A ssign
e plyiCh fpat

Selecting the elements on the graph it's possible to display a window containing Name, step Description, Service and its
Properties.
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N Variables pet LJ
ceiveInpua : Mamespace |urn, 7 retprocess |
\ / input B ;i
e ,

output Mame |FirstPracess. Assign_v_1 |

Description | |

Properties

bssign AzzignementFrom_1 =tns:FirstProcessResponse xmins:tns="urn.firstproc

7
A

AszignementTo_1

!
AzsignementFrom_2 Iinput
|0utput

bssignementTo_2 Ioutput

im, e rvicebindingname |AutoGeneratedBinding

im.zerwicesntity iSe ruiceGeneric
im, serwicenams |Gener1’cSe rice
originallame !Assign
totaldssignements |2

walidate !no
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7.3 Process Instances List

Selecting the icon Process Instances List (ﬂ!i) the process instances list is showed. The list contains:
» Id: identifier of process instance.

Process: process name.

Iter: name of the iter (optional) associated to the process instance.

Instance: attributes identifying the iter instance (optional).

Start: start execution time.

End: end execution time.

Server: server IP address that executed the process.

State: instance state. It can be active (yellow ), executed (green V) or fault (red X).

YV V V V V V V V

a : visualizes the process execution detail.

& & A o @ik 2 A4 G & Process Instances List

| ter

I —_— Processes | Services || Connectors
Iter Type | All Processes W - -
) (4 Server | localhost e Page 1of 1 ‘g;

Id Process Iter Instance Start End Server State
1 FirstProcess SFZE09 12:46:06 PM 92509 12:46:08 P 192,168, 1,65 4 ﬁnﬁ

7.3.1 Process Instance Graph

Selecting the a icon from the process instances list it's possible to display the graph representing the execution of the
process.
The color of the component represents the component state: the green color means executed, the yellow color means

active and the red means error.
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ﬁ &I I% 'r.-'| ':% hﬂ:l E g o8 A ‘g‘
,.r"f ”_"\\_ Variables
{’eceivelnp'l.la
% / input =
- output
L "\I
[ Assimn J
\_ >
2 plyCha fpnat

Selecting the = icon corresponding to the variable on the right side, the variable runtime value will be displayed. If the

process has been executed, the last value of the variable will be displayed.

aria F X
it Variable Value ™, [_]lx]

=Mmessage = =payload==FirstProcezsResponse
input 3 |=minz="urn, firstprocess"= <input=My First

e |Process< finputs < fFirstProcessResponse - < /payload-
“lefmeszage=

output

Selecting the elements on the graph it's possible to visualize the window containing Detail and Relevant Data.
The Relevant Data tab contains the messages having as destination the component selected. Selecting the XML link in
the list, all the variable modifications will be visualized. For example, selecting the Assign step, then the Relevant Data
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tab and XML message, the console will display the two changes to variable output executed in this step: the first for
initialization, the second for the assignment from input variable to output variable.

ﬁ % ﬁ'i 3 Q ILH:I E Q n"'E Lo & Instance 1 of Proce:
_—_—
Detail Relevant Dats *
/,_\ i etail ™| Releval a s, |:|
%Eceivequ:ui‘j — Id State Start Message Attachments Data syncState Properties
\ J input % 2 Executed 12:46:00 PM | HML i] =8
~ !
output S
output ] output |
™ = <Mmessage >

Assign Bl <payloads
&l FirstProcessResponse

xmlns "urn. firstprocess"s
& plyChu tput

<input =dy First Process <finput >

BPEL processes with Spagic3 ver. 1.0, July 30, 2010 - pag. 23/ 28

licensed under the Creative Commons Attribution-ShareAlike License. To
- view a copy of this license, visit http://creativecommons.org/licenses/by-
COMMONS D E E D 58/30/

@Creatl\le Engineering Ingegneria Informatica S.p.A., 2007, 2010. This work is




BPEL processes with Spagic3

SN Spagic

Open Source SOA Universal Middleware

8 Samples

This section will show some examples of the BPEL constructs and their corresponding mapping in the console.

8.1 Flow activity

The flow activity has been represented with a step start-Flow that identifies the start end a step end-Flow that identifies

the end. The names start-Flow and end-Flow have been built from the original activity name adding the prefix start- and

the suffix end-.

@

e

= main

& | receivelnput

= As5ign

= Seql

= #fssl

2| replyOutput

- SeqZ

= Bss?

ik .
."'/ 1"-.
recedrelnput
‘x\ i — *

Dekail b

o =)
bssizn

\ !

- s

o .Y

e plyCha fpuat
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8.2 Wait activity

L F N
t‘eceivelnpuﬂ
© main -.\. !.f;

& | receivelnput

n n 4 -\
(L) wiait Waat

] [ ] \ g

. o

= Assign
3| replyCutput P Y
Assign
=l II‘\.._ _,)l
®
e plyrChatpat
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l

& | receivelnput

= initZounter

£

E’eceivel
5\

The Repeat Until has been mapped with two steps that identify the start and the end of the cycle. The names start-

Repeat and end-RepeatUntil have been built from the original activity name adding the prefix start- and the suffix end-
S,Z Process repeatBpel

npuﬁ-
b

:

5 RepeatUntil

= #Assign

|
= Assignl

(;I replyOukput

oF

@

\'I
Assignl |
- S
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8.4 IfElse, Throw, Fault Handler

if

= Sequence

= AssignvalueScopeariable

= Skepl

ol
v
Catch All
= SeguenceCacthal
= Assign

2| ReplyCatchall

= main

Q | start

= Initializevariable

@ 2]
Exceptionl
Else If Else If
= seql
= Sequencel = Sequenced =
= Stepd
= stepz = step3 Gl

2 ThrowExceptionl U2 ThrowException2

| end
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/
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/
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9 Related documents

The publications listed in this section are considered particularly suitable for a more detailed discussion of the topics
covered in this document.

1. Spagic JBI Components.doc: detail document about ServiceMix and Spagic JBI components.
2. Spagic Console.doc: detail document about Spagic Console monitoring application.
3. Spagic Studio User Guide.doc: detail document about Spagic Studio environment.

BPEL processes with Spagic3 ver. 1.0, July 30, 2010 - pag. 28/ 28

licensed under the Creative Commons Attribution-ShareAlike License. To
view a copy of this license, visit http://creativecommons.org/licenses/by-
sa/3.0/

@Creatl\le Engineering Ingegneria Informatica S.p.A., 2007, 2010. This work is

COMMONS DEETD




